電子檔案規格、轉檔與上傳作業說明

Guide of ETDS File Format & Conversion &

ETDS Service Workflow
I. Guide of ETDS File Format ........................................................................................................4
   File Format ..................................................................................................................................4

II. MS Word File Format ...............................................................................................................5
   Recommended version ..................................................................................................................5
   Font settings ...............................................................................................................................5
   Picture Format ............................................................................................................................5
   The use of special symbols .........................................................................................................5

III. Notes for before file conversion to PDF ..............................................................................6
   Anti-virus ...................................................................................................................................6
   scanning ......................................................................................................................................6
   File merger ..................................................................................................................................6
   Confirm your thesis/dissertation file ............................................................................................6
   Special treatments ......................................................................................................................6

IV. Page layout after files being combined ..............................................................................7
   Page layout ..................................................................................................................................7
   steps .............................................................................................................................................7

V. File converting process ...........................................................................................................9
   Acrobat Distiller 6.0 .....................................................................................................................12
   Acrobat 6.0 ..................................................................................................................................15
   Acrobat 7.0 ..................................................................................................................................18
   Special treatments ......................................................................................................................18
   File Naming ...............................................................................................................................19
   Inspection items before uploading files .....................................................................................20

VI. Upload File ............................................................................................................................21
   Login in the E-Theses & Dissertations Service ........................................................................21
Basic Information of thesis / dissertation ............................................................ 22
Set up committee members................................................................................... 23
Upload Thesis/ Dissertation .................................................................................. 24
Authorization Submit for process ........................................................................ 25
Audit notice ............................................................................................................ 28
I. Guide of ETDS File Format

<table>
<thead>
<tr>
<th>File Format</th>
<th>Please upload PDF file. If you have conversion problem, please re-upload MS Word file or PostScript (.ps) file.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Using MS Word is recommended to write theses; use Acrobat 5.0 or higher to convert the theses into PDF files.</td>
</tr>
<tr>
<td></td>
<td>The NTU watermark is needed to be attached to the E-theses. (If the thesis is written with MS Word, the watermark is needed to be attached; if it’s written with Tex / Latex then the watermark is not needed)</td>
</tr>
<tr>
<td></td>
<td>Please set up content protection measures for the PDF files to prevent copying and pasting</td>
</tr>
<tr>
<td></td>
<td>The PDF content can have word search and be embedded with Chinese fonts.</td>
</tr>
</tbody>
</table>
## II. MS Word File Format

<table>
<thead>
<tr>
<th><strong>Recommended version</strong></th>
<th>It is recommended that your thesis be written with Word; do not change the paper’s “layout setting” (do not change the default) to ensure correct PDF file converting.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Font settings</strong></td>
<td>The following fonts are recommended to be used to avoid the words not being properly presented during PDF file converting.</td>
</tr>
<tr>
<td></td>
<td>- Chinese font：標楷體，細明體，新細明體</td>
</tr>
<tr>
<td></td>
<td>- English font：Times New Roman，Arial，Arial Black，Arial Narrow，Bookman Old Style，Comic Sans Ms，Courier New</td>
</tr>
<tr>
<td></td>
<td>- Just a reminder, if your thesis is not written with the above-mentioned fonts, then your e-thesis may not be able to provide the full-text search service.</td>
</tr>
<tr>
<td><strong>Picture Format</strong></td>
<td>To avoid errors during file conversion process, please use .gif and .jpg picture format.</td>
</tr>
<tr>
<td></td>
<td>Try not to use .bmp format, if there are other picture formats, please convert them into .gif and .jpg format to avoid the file being too big.</td>
</tr>
<tr>
<td><strong>The use of special symbols</strong></td>
<td>If your thesis requires having special symbols inserted, please be sure to use the Symbol font.</td>
</tr>
<tr>
<td></td>
<td>If the symbol that you need does not exist in the Symbol font, it is recommended to use the Microsoft formula editor in Word for editing.</td>
</tr>
</tbody>
</table>
### III. Notes for before file conversion to PDF

<table>
<thead>
<tr>
<th>Anti-virus scanning</th>
<th>Please use anti-virus software to check if there are viruses in the original thesis, and after scanning, the following operating can be proceeded.</th>
</tr>
</thead>
<tbody>
<tr>
<td>File merger</td>
<td>Please convert the entire thesis as one file.</td>
</tr>
<tr>
<td></td>
<td>If the thesis document has many Word files, please combine these Word files into one file and number the pages before PDF file conversion.</td>
</tr>
<tr>
<td></td>
<td>Please combine cover, directory, chapters, pictures, and references into one file for file conversion.</td>
</tr>
<tr>
<td>Confirm your thesis/dissertation file</td>
<td>Please make sure that the e-thesis contains all the paper thesis’ contents, including title page, thank notes or foreword, Chinese and English Abstract, charts and index, the paper, reference, and appendix, and the content and page order of the e-thesis please refer to the written paper.</td>
</tr>
<tr>
<td>Special treatments</td>
<td>If a defined program is used to create the characters, the C:\windows\eudc.euf and eudc.tte in the computer can be copied to your computer that is going to convert files, and after pasting on the computer’s eudc.euf and eudc.tte, the file can be converted.</td>
</tr>
</tbody>
</table>
IV. Page layout after files being combined

<table>
<thead>
<tr>
<th>Page layout steps</th>
</tr>
</thead>
<tbody>
<tr>
<td>- After the files are combined, please adjust the page orders to match the paper thesis, if there are any questions about page layouts, please follow the following steps to process:</td>
</tr>
<tr>
<td>(1) Please go the last page’s last line of the page going to be separated</td>
</tr>
<tr>
<td>(For example: Page 11 is the text, please use Arabic numerals coding, and the first 10 pages will be using Roman numerals coding, and please go to the last line of page 10)</td>
</tr>
<tr>
<td>Select toolbar ( \text{Insert} \rightarrow \text{Break} )</td>
</tr>
<tr>
<td>(2) Select sub-section symbol type ( \rightarrow ) start from the next page</td>
</tr>
<tr>
<td>(3) At this point the article had been set to different sections, click ( \text{Insert} \rightarrow \text{Page} \rightarrow \text{Format} )</td>
</tr>
</tbody>
</table>
(4) Click **format**, the following screen will show:

Then select the “format” that the page number is going to be shown, and then select “page coding method” to edit your e-thesis’ page code.

Just a reminder, the e-thesis page code shall match the paper thesis page code!

(5) If the article is required to be divided into several paragraphs, the above-mentioned steps can be repeated to edit the page number.
V. File converting process

(6) Please download the "NCHU watermark file" into your local computer.

From [http://140.120.80.22/files/watermark_nchu_WORD.jpg](http://140.120.80.22/files/watermark_nchu_WORD.jpg)

"NCHU watermark file"

(In order to maintain the consistency of quality paper, please do not change the size of watermark!)

(7) Open a Word file, on the title page; click View → header / footer. (Ensure that watermark appears in the center of each page)
(8) Insert the watermark image: Click **Insert → Picture → From the file**

Note: After the watermarks are inserted, the layout will be a bit messy, please do not panic, just adjust with the following steps.

(9) Double-click on the picture, a picture format dialog will appear.

(10) Change watermark image format: switch labels to **Configuration** → click on **Advanced**.
(11) Then switch labels to **Text around the pictures** and click on **Text in the front**.

(12) Switch label to **Image Position** and in **Horizontal Alignment** click on **Centered** of the page, and in **Vertical Alignment** click on **Centered** of the page → press **OK**

(13) Click on **Close** header and footer, the watermark image will appear in the center of each page.

(14) Save file.

(15) After the watermark is added, you can start to convert files.
| **E-thesis file conversion and enhancing thesis protection measures** | (1) Process PDF file transferring in the computer classroom of the school computer center, the main library, and the Law and Social Sciences Library, or the medical Library.

(2) Please use Acrobat 6.0 or higher to convert the theses into PDF files.

(3) Do not transfer files using the express button of “convert to Adobe PDF” on the top-right of Word to avoid errors while loading PDF files to the database. |
| **Convert PS file to the PDF file that prevents copying / pasting** | (1) General common documents editing files, such as: text file (.txt), Microsoft Word file (.doc), etc format usually can be converted into PDF files easily.

The PostScript (.Ps) format frequently uses Science and engineering departments required to converted to PDF files through Acrobat Distiller, and before converting the PS file, the PDF protection can be set on the Acrobat Distiller to ensure that the converted PDF files have the protection measures (Anti-copy / paste), please see the following icon description: |
| **Acrobat Distiller 6.0** | Acrobat Distiller 6.0

- Open Acrobat Distiller 6.0, "Adobe PDF settings", select "Standard", and then select [Settings](#) |
In **Setting**, pull-down the menu, at the end select **Protection**.

After clicking on **protection**:

(i) **Do not check request password to open the documents**

(ii) Please **check use password restrictions on the settings of printing, editing and prevention for the documents**, and set up your personal **password**.

(iii) In the **Print menu**, select **high-resolution**

(iv) In the **allow changes** menu, select **no**

(v) **Do not check activate copying text, images and other contents**

After checking **OK**, convert **PS file to PDF file**.
Click **OK** an authority to confirm the password window will show, please enter the password you set before again, and then click **OK**.

Save the prepared to be converted PS file on the desktop.

Pull the PS file to the Acrobat Distiller 6.0 window, at this time, it will bring up the 'security' message box, select **maintain**.

Acrobat Distiller 6.0 will automatically convert files to PDF files, and save them on the desktop with the same names, and the file converting and protection are completed at the same time.
If you use the most common MS Word to write your thesis, you can go through Adobe Acrobat to convert MS Word files to PDF files, and add prevention of copying/pasting to your PDF files. Due to different versions of Adobe Acrobat, the converted name may not be the same, please follow the instructions for file conversion.

<table>
<thead>
<tr>
<th>Acrobat 6.0</th>
<th>Acrobat 7.0</th>
</tr>
</thead>
</table>

**Acrobat 6.0**

- Open your e-thesis MS Word file in a computer with Acrobat 6.0
- Select: **File → Print**

![](https://example.com/screenshot)

- Select the printer: Adobe PDF
- Click **Content** → switch to Adobe PDF Settings
- Select Adobe PDF protection menu: select **reconfirm the protection of all the work**, and click **Edit**


Click on **Edit**, the **Adobe PDF protection** window will appear:

(i) **Do not check** request password to open the documents

(ii) **Please check** use password restrictions on the settings of printing, editing and prevention for the documents, and set up your personal **password**

(iii) In the **Print** menu, select **high-resolution**

(iv) In the **allow changes** menu, select **no**

(v) **Do not check** activate copying text, images and other contents
After checking, click **OK**, go back to Adobe PDF settings, then check **do not send fonts to Adobe PDF** and then press **OK**.

After all the moves are set, continue to click on two **OK**, the saving location for the converted PDF file, after the location is selected, then click “OK” to immediately process file converting, when the file is successfully converted, it will automatically open the PDF file that cannot be copying/pasting.
Acrobat 7.0

- Open your e-thesis MS Word file in a computer with Acrobat 7.0
- Select: File → Print

- Select the printer: Adobe PDF
- Click Content → switch to "Adobe PDF Settings"
- Select Adobe PDF protection menu: select reconfirm the protection of all the work, and click Edit
- The follow up prevention moves are the same as the method of Acrobat 6.0.

Special treatments

- If a defined program is used to create the characters, the C:\windows\eudc.euf and eudc.tte in the computer can be copied to your computer that is going to convert files, and after pasting on the computer’s eudc.euf and eudc.tte, the file can be converted.
File Naming

- Do not use 'Chinese' file names, file names cannot contain full-text spaces, or some special characters, such as: ~ . * / \ ( ) + [ ] {}, otherwise errors will appear when loading to the database.

- Save PDF files on the desktop to ensure whether PDF files can be opened, if it can be opened, then the conversion procedure is completed.
After the successfully converted PDF file is opened, please check if your PDF file matches your paper form. The inspection items:

(i) Whether to add more PDF protection?

(ii) When adding more protection, do not check “use password to open PDF” and “no printing” these two options

(iii) Whether the PDF file can be opened normally?

(iv) Whether to add the watermark?

(v) Whether the entire thesis is converted into a PDF file?

(vi) Check if the total page amount and the starting and ending page number in each chapter of the PDF file match the paper thesis?

(vii) Whether the text content of the PDF file has ASCII?

(viii) Whether the font of the PDF file match the paper thesis font?

If you have any problems, please contact us:

Phone: 04-22840700 # 145 or 142
E-mail: reflib@dragon.nchu.edu.tw
VI. Upload File

- Check your library account and Password (PIN)
  If the ID/password is forgotten, please contact the library. Phone: 04-22840700 # 145

- Login in the E-Theses & Dissertations Service:
  From: Login from the school library webpage, or type in the web site address directly: http://etds.lib.nchu.edu.tw

Please enter your library account and Password (PIN), then click Login.
Please provide the basic Information of thesis / dissertation

- If you find that your thesis has insufficient information, click on “save temperately”, the system will keep the information you have entered, please remember to return within 30 days to continue to conduct operations to avoid the information being deleted!

- Enter completed, click **Next**
Please provide the information of your committee members (contain Advisor/Advising professor)

- The system default has set three Committee Members’ information, if there are more than three Committee Members, click Add Committee Members to add more information.
- If the title of the committee member is not instructing professor or commissioner, please email us, we will add the committee member’s title for you.
- The Chinese name and the title of the commissioner must be filled.
- After completing the above information, please click “next”
Please Upload Thesis/ Dissertation file:

1. Please upload all the chapters within one single file.

2. Please upload PDF files, click [browse] to select the right file, and then click [upload]. After the file is uploaded, the system will automatically change its name.

3. If the original format of your thesis/dissertation is PostScript(.ps), you can convert PostScript file to PDF file by Acrobat Distiller and then upload it.

4. If you have difficulties in PDF converting, then you could upload the MS word file by the field named 'Upload the MS word file.' Or, you could upload your PostScript file by the field named 'Upload the PostScript (.ps) file.'

(5) If you have any problems, please contact us:
Phone: 04-22840700 # 145 or 142
E-mail: reflib@dragon.nchu.edu.tw
Please Choice the Authorization

1. 您的紙本論文全文資料 無償授權教育部指定送繳之圖書館及中興大學圖書館，為學術研究之目的予以重製，惟每人以一份為限。
   
i. 紙本論文公開陳列上架時間
   
ii. 已公開陳列上架之紙本論文重製
Would you agree to authorize your thesis/dissertation with royalty fee?

i. Yes, I agree to authorize my thesis/dissertation with royalty fee
   
   • Please donate my royalty fee to school library as a development fund (default).
   
   • Yes, I agree to authorize my thesis/dissertation with royalty fee. Please contact me for the royalty fee redeem.

ii. Yes, I agree to authorize my thesis/dissertation without royalty fee

iii. No, I don't agree

[ ] agree to authorize my thesis/dissertation with royalty fee to myself: Please provide your contact information for the notification of your royalty fee redeem.

  • Your Frequently Used E-Mail
  • Contact Phone Number
  • Contact Address

Please note that if your contact information is changed, please contact your library for the update. If the royalty fee is not redeemed for more than one year, it will automatically donate to "School Development Fund" for library use

[ ] Agree to authorize my thesis/dissertation with royalty fee, Please choose the open policy for you thesis/dissertation

[ ] Submit for process

※此句會再翻譯成英文

Submit for process
After all the above-mentioned processes, please select “submit auditing immediately”

If you find that your thesis has insufficient information, click on “save temporarily”, the system will keep the information you have entered, please remember to return within 30 days to continue to conduct operations to avoid the information being deleted. Thanks for your assistance and help!

Click complete when the window of “your thesis has been submitted for auditing…”, it means you have successfully submitted your thesis for auditing!

Thesis/dissertation is submitted and it would take 2 working days for the process. Upon its done, we will notify you with the result of submission via E-Mail. Please kindly contact us if you still don't get any notification from us after two days upon your submission day. Or you can login in E-Theses & Dissertations Service and search the result of submission. phone: 04-22840700 # 145
After you receive an audit notice:

- The pending time is about 2-3 days, if you haven’t received a notice more than 3 days, please call us or log in to the system to check!

- Approved
  
  Congratulation! Your submission of thesis/dissertation is approved!
  
  If you would like to authorize your thesis/dissertation to CETD, please print out the authorization agreement and sign it; then hand-in the signed agreement and printed thesis/dissertation to library for gradation process.

- Disapproved

  Sorry! The thesis/dissertation submission of you student is disapproved
  The reason to disapprove: Can not open the uploaded PDF file

  Please review your thesis/dissertation and then submit after correction!
  Thanks for your assistance and help

  To ensure that your thesis can be approved, please ensure the PDF file content quality! If you have any problems, please contact us:
  
  Phone: 04-22840700 # 145 or 142
  E-mail: reflib@dragon.nchu.edu.tw